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Tait Electronics Ltd has made every effort to ensure the accuracy of the information
in this manual. However, Tait Electronics Ltd reserves the right to update the

calibration system and/or this manual without notice.
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About the calibration system

The Tait Orca series of radios has been
designed to be totally electronically tuned.
The calibration process uses a PC running
the calibration system, which is connected
to a radio via a calibration test unit. The
calibration system leads the operator
through a series of tests and uses the
information from these tests to calibrate
and program the radio.

The calibration system:

■ reads information from the radio,
such as the radio�s calibration
database;

■ guides the operator through a series of
calibration tests;

■ calculates calibration database items
from information obtained in the
calibration tests; and

■ programs the radio�s calibration
database.

These tasks will typically be performed in
sequential order, although there may be
times when some tests will not be
performed.

System requirements
The Tait Orca calibration system requires:

■ an IBM compatible PC with an 80386
microprocessor (or better);

■ MS-DOS version 5.0 or higher;

■ 2 MB of RAM;

■ a VGA colour graphics display;

■ a hard disk drive with 2 MB free space;

■ a single 3.5 inch floppy disk drive
(1.44 MB capacity);

■ a printer (if you intend to keep a hard
copy of calibration data); and

■ a Microsoft or compatible mouse and
driver (if you wish to use the program
with a mouse).

Equipment supplied
The calibration system is supplied as part
of the Tait Orca Service Kit (OPA-SV-001);
see the Tait Orca Handportable Service
Manual (IPN 449-51000-xx) for a list of
equipment supplied.

NOTE: The calibration system includes online help that is updated at each software
release. If information in this manual conflicts with that in online help, the

information in the online help can be considered the most up-to-date.
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Equipment required
Other items required for calibration but
not included as part of the service kit are:

■ RF communications test set (e.g.
HP8920, MI2945/55, CMS52);

■ digital current meter capable of
measuring current up to 3 A accurate
to two decimal places;

■ DC power supply, 7.5 V, 3 A for
handportable radios; and

■ DC power supply, 13.8 V, 7 A for
mobile radios.

Warning!
Instructions in this manual and the
calibration system assume you are
calibrating a radio using a test set. If you
are calibrating using discrete test
equipment, adequate protection must be
provided on all inputs and outputs.

What radios does the calibration
system apply to?
This manual describes the calibration of
Tait Orca series handportable and mobile
radios. The calibration system cannot be
used to calibrate Tait T2000 or T3000
series radios.

Conventions
Throughout this manual, the following
conventions are used:

■ screen names, field names, screen
buttons and computer keys are shown
in bold sans serif;

■ commands you must type are shown
in bold;

■ information you must provide is
shown <in brackets>;

■ specific entries and available settings
for screen fields are shown �in single
quotes�; and

■ names of computer directories and
files are shown in ALLCAPS.

These conventions are illustrated on
page 5.
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Insert the supplied disk in the floppy drive
and at the DOS prompt, type a:install (if the
disk is in drive A) or b:install (if the disk is in
drive B). Press Enter. The b:install is the

command to type in.

Press the Enter key to
initiate the command.

To start the calibration system, type
c:\<pathname>\orcacale, then press Enter.

Type in the command
c:\<pathname>\orcacale,
substituting the directory in
which the calibration system
was installed for
<pathname>.

Press the Enter key to
initiate the command.

■ Select the file ORCA.ICO, then select
Open.

Open is the name of
a screen button.

ORCA.ICO is the
name of a file.

Adjust Mute Open Adjustment until a single
increment causes Mute Status to change
from �Closed� to �Open�.

Mute Open Adjustment
and Mute Status are the
names of fields.

‘Closed’ and ‘Open’
are the values Mute
Status can be set to.
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Installing the calibration system

The Tait Orca calibration system cannot be
run directly from the distribution disk. It
must be installed on your hard disk, which
requires up to 2 MB of free disk space.

If you are installing from DOS, insert the
supplied disk in the floppy drive and at the
DOS prompt, type a:install or b:install,
then select Enter.

If you are installing from Windows 3.x, in
Program Manager, select Run from the
File menu. Type a:install or b:install, then
select Enter.

If you are installing from Windows 95,
select Start from the taskbar. Select Run
and type a:install or b:install, then select
Enter.

The installation program will guide you
through the installation process. Read the
information presented on the screen
carefully. After installing the software,
place the original distribution disk in a
safe place.

Drive and path options
You will be asked to enter the drive and
path to which you want the software
installed. If you do not change the default
directory, then the files will be copied to
the \TAITORCA\CALIB directory on the
target drive. It is recommended you use
the default directory setting, especially if
you have already installed or intend to
install other Tait programming and
support software packages.

You may wish to include the
\TAITORCA\CALIB directory in the DOS

search path so that you can start the
calibration system from any directory.
Consult your DOS manual for information
on how to add the directory to the search
path.

Installing a mouse
To use this program with a mouse, your
mouse driver software must first be
loaded. Usually a command such as
c:\<pathname>\mouse.exe can be added
to your AUTOEXEC.BAT file to load the
mouse driver automatically when your
computer starts up. See the instruction
manual for your mouse software for more
details.

If a mouse is connected to a serial port on
your computer, you must have a second
serial port available to connect to the radio
you wish to read or program.

Setting up a program item
(Windows 3.x)
If you are running the calibration system
from Windows 3.x, you can set up a
program item for the calibration system.
You can then double-click on the program
item to start the calibration system.

To set up a program item:

■ Open the group in which you wish to
set up the program item.

■ From the File menu, select New.

■ Choose Program Item, then select
OK.
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■ A Program Item Properties window
will appear. Select Browse, then move
to the directory the calibration system
was installed in.

■ Select ORCACALE, then select OK.

■ You will then be returned to the
Program Item Properties window.
In the Description field, type a name
for the program item, then select
Change Icon...

■ A message will appear saying there are
no icons available for the specified file.
Select OK to choose an icon.

■ The Change Icon window will appear
displaying a selection of icons. Select
Browse, then move to the directory
the calibration system was installed in.

■ Select ORCA.ICO, then OK.

■ You will be returned to the Change
Icon window. Select OK.

■ You will be returned to the Program
Item Properties window. Select OK
to close the Program Item Proper-
ties window; the program item will
appear.

Setting up a shortcut
(Windows 95)
If you are running the calibration system
from Windows 95, you can set up  shortcut
to the calibration system. You can then
double-click on the shortcut to start the
calibration system.

To set up a shortcut:

■ Right-click on the desktop, and choose
New, then Shortcut from the pop-up
menu.

■ A Create Shortcut dialog box will
appear. Select Browse, then move to
the directory the calibration system
was installed in.

■ Select ORCACALE, then Open.

■ You will then be returned to the
Create Shortcut window. Select
Next>.

■ Type in a name for the shortcut, then
select Next>.

■ You will then be prompted to choose
an icon. When you have done so,
select Finish and the shortcut will
appear on the desktop.

You can change the icon for the shortcut to
the Tait Orca icon. To change the icon:

■ Right-click on the shortcut and select
Properties from the pop-up menu
that appears.

■ A Properties window will appear.
Select the Program tab at the top of
the window, then select Change Icon.

■ The Change Icon window will appear.
Select Browse, then move to the
directory the calibration system was
installed in.

■ Select the file ORCA.ICO, then select
Open.

■ You will then be returned to the
Change Icon window, in which the
selected icon will be displayed. Select
OK.

■ You will then be returned to the
Properties window. Select OK to close
the Properties window and apply the
changes.
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Setting up the test equipment

The calibration test unit provides an
interface between the test equipment and
the radio being calibrated. The calibration
test unit is compatible with Tait T3000
series radios; however, the calibration
system itself can only be used with Tait
Orca series radios. The calibration test unit
and setup are shown in Figure 1.

Connect the supplied calibration cable to
the calibration test unit at the Radio
connection and to the radio at the
accessory connector.

For handportable radios, you may need to
remove the rear accessory cover. Remove
the battery, then insert the end of a key
underneath the bottom edge of the
accessory cover and lift to remove the
cover. When attaching the accessory
connector, ensure that the lever is in the
upright position. Once the connector is in
position, rotate the lever 90 degrees
counterclockwise to lock it in place.

The RS232 to modular phone jack cable
supplied connects to the calibration test
unit via the Computer connection and to
the PC via one of the COM ports. If a

Radio

432

1

1

2

3

4

Audio input
from test set

Audio output
to test set

Connection to
radio accessory
connector via
calibration
cable

DC service
adaptor with
regulated power
supply set for 7.5
V at battery
terminals when
transmitting

RF in from test set via
antenna connector

Connection to PC COM
port via RS232/
modular phone jack
cable

Switches:
Dummy load switch

External PTT
Audio output switch

Audio input switch

Figure 1: The calibration
test unit and setup
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mouse is connected to COM1 or COM2,
the calibration system will detect it and
automatically assign the test unit to
whichever of COM1 or COM2 is not being
used by the mouse. However, the
calibration system will not detect other
serial devices, such as a modem, and if you
wish to connect the test unit to COM3 or
COM4, you will need to change the COM
port setting in the Defaults window
(Utility menu). Be sure you use the correct
COM port setting; otherwise you may have
problems communicating with the radio.

There are four switches on the calibration
test unit.

■ The external PTT (Rx/Tx) switches
the radio between receive and
transmit modes.

■ The audio output switch (calibration
test unit�s speaker) switches between
the speaker (Speaker), a dummy load
(Load) and the radio�s internal
speaker (Int.). The internal speaker
position only applies to Tait Orca
handportable radios.

■ The audio input switch (Mod Audio/
Off/Mic Audio) switches between the
radio�s MOD-AUDIO input (Mod
Audio/MOD-AUDIO), Off (no audio
input) and the external microphone
audio input (Mic Audio/EXT-MIC).

■ The dummy load switch (8ΩΩΩΩΩ/16ΩΩΩΩΩ)
switches between dummy loads of 8Ω
and 16Ω. 8Ω Ω Ω Ω Ω applies to Tait Orca
mobiles radios and T3000 series
radios; 16ΩΩΩΩΩ applies to Tait Orca
handportable radios.

The external PTT should be set to Rx for
all calibration tests. Instructions on other
settings and connections for different

calibration tests are given in the instruc-
tions for each test.

If the PA Bias Calibration test is to be
done (handportable radios only), connect
a digital current meter in series with the
power supply to the radio. Connect the
radio�s antenna connector to a 50ΩΩΩΩΩ load/
input.

Power supply during calibration
Once connected, the radio must be turned
on before it can be calibrated. To ensure
the radio does not turn itself off during
calibration, use the supplied DC service
adaptor.

For handportable radios, set the regulated
power supply to 7.5 V at the battery
terminals when transmitting. Confirm that
7.5 V is delivered to the radio when
transmitting by first connecting the radio�s
antenna port to the test set�s high power
input. Then set the calibration test unit�s
external PTT to Tx and monitor voltage on
the bottom contacts of the DC service
adaptor. Be sure to switch the external
PTT to Rx before beginning the calibration
tests.

For mobile radios, set the regulated power
supply to 13.8 V at the DC service lead test
terminals when transmitting. Confirm that
13.8 V is delivered to the radio when
transmitting by first connecting the radio�s
antenna port to the test set�s high power
input. Then set the calibration test unit�s
external PTT to Tx and monitor voltage at
the DC service lead test terminals. Be sure
to switch the external PTT to Rx before
beginning calibration tests.
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Figure 2: Calibration system main window

Using the calibration system

The calibration system can be run from
DOS or from Windows.

To start the calibration system from DOS,
change to the directory the programming
system was installed in and type orcacale,
then select Enter. Changing directories is
not necessary if you have included the
target directory in the search path.

To start the calibration system from
Windows 3.x, in Program Manager,
select Run from the File menu. Type
c:\<pathname>\orcacale then select Enter.
If you have set up a program item, you can
start the calibration system by double-
clicking on the program item.

In Windows 95, select Start from the
taskbar. Select Run and type
c:\<pathname>\orcacale then select Enter.
If you have set up a shortcut, you can start
the calibration system by double-clicking
on the shortcut.

The main window
The main window for the calibration
system is shown in Figure 2. This is the
window that appears when you first start
the calibration system. Whenever you
finish working in another window, you will
return to the main window.

The menu bar shows the titles of five
menus:

■ use the File menu to create, save and
load calibration databases, and exit
the calibration system;

■ use the Radio menu to read a
calibration database from a radio and
program a radio;

■ use the Calibrate menu to carry out
calibrations tests;

■ use the Utility menu to set defaults,
print data and send test commands to
a radio; and

■ use the Help menu to access the
Navigation Guide and information
about the calibration system.
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The keywords on the main menu bar are
selected either by clicking on them with
the mouse or by holding down the Alt key
and selecting the underlined letter.

The bar at the bottom of the window tells
you the name of the calibration database
currently loaded. If you have just started
the calibration system or created a new
file, this will read �Default Database�.

You can exit the program and return to the
DOS prompt or Windows by selecting Exit
from the File menu.

Online help
Online help is available throughout the
calibration system. Pressing the F1 key
displays online help specific to the screen
you are currently working in. Some
windows have a Help button, which
displays help for that window.

The Navigation Guide option in the Help
menu provides general information on
using the calibration system.

Navigating
The calibration system can be used with or
without a mouse. The keystrokes and key
descriptions shown in Table 1 are common
to all calibration system windows and
menus.

Scroll bars
A scroll bar appears as:

The value to the right of the scroll bar
reflects the current setting.

Using the keyboard, move onto the scroll
bar using the Tab key; once selected, the
slider button will be highlighted. Change

the value in steps of one with the left and
right arrow keys, in steps of five with the
up and down arrow keys, and in steps of
ten with the PageUp and PageDown keys.
Change the value to its lowest possible
value with the Home key and to its highest
possible value with the End key.

Using the mouse, change this value in steps
of one by clicking on the arrow keys, in
steps of 10 by clicking on either side of the
slider button, and in large steps by clicking
on and dragging the button.

List boxes
A list box is used for fields that have a
range of possible values and appears as a
box with an arrow at the righthand side:

Longer lists will also have a scroll bar
down the side.

Using the keyboard, select the desired
value by using the Tab key to select the
field, then select Enter to open the drop-
down menu. Use the arrow keys to scroll to
the desired value, then select Enter.

Using the mouse, click on the arrow to the
right of the field to open the drop-down
menu, then click on the desired value.

Radio buttons
Radio buttons appear as:
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Radio buttons are used where only one
value in a set of values is possible; the
filled-in button is the current value and
selecting any of the other buttons makes
that the current value.

Using the keyboard, select the desired
value by moving on to the field using the
Tab key. Then use the arrow keys or the
Home and End keys to select the desired
value.

Using the mouse, select the desired value
by clicking on it.

Screen buttons
A screen button appears as a box and
contains a command, such as OK.

Using the keyboard, use the Tab key to
select the button, then select Enter to
carry out the command. You can also

select the button by pressing the Alt key
and the underlined letter on the button;
for example, pressing Alt-o will select the
OK button.

Using the mouse, click on the button to
carry out the command.

Edit boxes
Edit boxes appear as a box, sometimes
with default text entered.

Select the box using the Tab key or by
clicking on it with the mouse. A text cursor
will appear in the box. Type in the data
and select Enter to set the new value.

Keystroke Function

F1 Online help for the current window.

F3 Exit window and return to the main
menu.

F5 Refresh screen.

Alt Select the window menu bar. The
Alt key can be used together with
a hot key to select a specific item.
For example, pressing Alt-F-X in
the main window exits the program,
and pressing Alt-H in one of the
test windows brings up the help
screen.

Enter End edit and validate new value.

Tab Move to next window object.

Shift-Tab Move to previous window object.

Up arrow Increase the currently selected
value by 5.

Down arrow Decrease the currently selected
value by 5.

Table 1: Calibration system keystrokes and key descriptions

Keystroke Function

Right arrow Increase the currently selected
value by 1.

Left arrow Decrease the currently selected
value by 1.

PageUp Increase the currently selected
value by 10.

PageDown Decrease the currently selected
value by 10.

Home Changes the currently selected
value to its lowest possible value.

End Changes the currently selected
value to its highest possible value.

Key Description

OK Exit the window and save the data.

Cancel Exit the window without saving the
data.

Help Accesses context-sensitive help.
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Utilities
The Utility menu contains three options:
Defaults, Print and Test Commands.

Setting defaults
Select Defaults from the Utility menu and
the Defaults window (Figure 3) will
appear. In this window, set the COM port
that will be used to connect the calibration
test unit to the PC, the default file
extension and the default directory.

If you have a mouse on COM1, the
calibration system will automatically
detect it and will assign the calibration test
unit to COM2. If you wish to attach the
test unit to another port, choose the
desired port in this screen.

The file location and extension can help
you organise your calibration data. Data
file path determines the default directory
on your hard drive that will be used for
storing radio data files. The default is
�c:\taitorca\calib\ocsfiles�. Data file
extension determines the filename
extension for all data files. The default is
�ocs�.

COM port settings and problems
communicating with a radio
If you are having problems reading from or
programming the radio, there could be a
problem with the connection between the
radio and the computer. Check that:

■ the correct serial port is specified in
the Defaults window (Utility menu);

■ the calibration test unit is properly
connected to the correct serial port
connector;

■ the radio is properly connected to the
calibration test unit;

■ the radio type matches the software
being used; and

■ the radio is turned on.

If you still have problems reading from or
programming the radio and are running
the calibration system from Windows,
check that only one copy of the calibration
system is running and that no other
applications that use serial ports are
running. Such applications may prevent
access to the port even if they are not
actively using it.

Figure 3: Defaults window
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Figure 4: Print window

Make sure no other serial hardware device,
such as a modem, is trying to use the same
COM port as the calibration system. In
addition, another COM port cannot be
using the same interrupt at the same time
as the calibration system. For example, a
mouse and the calibration system cannot
be on COM ports that share the same
interrupt; however, a modem and the
calibration system can be on ports that
share an interrupt if the modem is not
used while the calibration system is being
used. Typically COM1 and COM3 use the
same interrupts, as do COM2 and COM4.
If you need to modify these settings, refer
to your DOS manual or online help.

If you still have problems, refer to your
DOS manual for information on configur-
ing hardware and troubleshooting serial
communications.

Printing data
Select Print from the Utility menu and the
Print window appears (Figure 4). The
preview box shows the information that
will be printed; use the scroll bars to see all
the information. Choose the printer port
the data will be sent to from the drop-

down list in the upper righthand corner,
and print by selecting the Print button.

Sending test commands to a radio
Select Test Commands from the Utility
menu and the Test Commands window
(Figure 5) will appear. Use this screen to
send test commands to an attached radio.

Scroll through the list of commands. Click
on the command and select Send to send
the test command to the radio. Returned
information will be displayed, together
with any error messages.

A full list of test commands is shown in
Appendix A.

Reading, loading and creating
calibration databases
When calibrating a radio, you must first
read the radio for:

■ radio variant information, such as
trunked/conventional and handport-
able/mobile, frequency band and IF
bandwidth;

■ radio software version;
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Figure 5: Test Commands window

■ radio database version; and

■ calibration database version.

Select Read from the Radio menu and the
Radio Read window (Figure 6) will
appear.

The field Current Status should say
�Radio successfully read�. If you select OK
when exiting the window, the calibration
database read from the radio will be used
in the calibration tests.

Radio ID Number indicates the radio�s
model number. If no radio is detected,
then this field will remain blank.

Frequency Band shows the frequency
band the radio operates at.

Band Type shows the radio�s receiver
bandwidth. Wideband radios are designed
to operate on 20 and 25 kHz channels, and
narrowband radios are designed to operate
on 12.5, 20 and 25 kHz channels.

Figure 6: Radio Read window
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Radio Type shows whether the radio is a
conventional or trunked handportable
radio or a conventional or trunked mobile
radio.

Radio SW Version shows the radio
software version, Radio DB Version
shows the radio database version, and Cal
DB version shows the radio�s calibration
database version.

For the fields Frequency Band, Band
Type and Radio Type, you can change the
information displayed if you are going to
use calibration information from one type
of radio to calibrate another type. This
information can be read from the radio�s
serial number on the back of the radio, e.g.
TOP-B1211 (see Figure 7).

Problems reading a radio
If you have a read a radio and the Current
Status field shows a message other than
�Radio successfully read�, you may not be

able to use that radio�s calibration
database for calibrating the radio. The
options available depend on the message
displayed.

If Current Status says �Radio not
detected�, make sure the radio is properly
connected to the calibration test unit and
that it is turned on, then select ReRead. If
the calibration system still will not read
the radio, check in the Defaults window
(Utility menu) that the correct COM port
is specified. The calibration system will not
detect Tait T3000 series radios.

If Current Status says:

■ �Error - incompatible calibration
database� or

■ �Error - incompatible radio database�

check that you have the latest version of
the calibration system. You will still be
able to carry out the calibration tests, but

Figure 7: The Tait Orca naming convention
Note that the naming convention is not intended to imply that any particular combination of radio
features is at present available or planned for later release.

1 conventional
2 trunked

TOX-XXXXX
Tait Orca

P handportable
M mobile

Channel spacing
1 20/25 kHz
2 12.5/20/25 kHz

1 Elan
2 Excel
3 Eclipse

Frequency
B 136-174 MHz
C 174-225 MHz
D 220-270 MHz
E 270-310 MHz
F 290-340 MHz
G 336-400 MHz
H*400-470 MHz
I 450-530 MHz Custom product

0 Default
1 Special*H band may be split into TOP-HxxxL (Rx 400-450 MHz,

Tx 400-440 MHz) and TOP-HxxxH (440-470 MHz)
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you will not be able to program the radio.
In addition, the calibration will be carried
out using the default database.

If Current Status says:

■ �Error - failed to read item 00� or

■ �Error - failed to read freq\band item�
or

■ �Error -failed to read database item�

check that the radio is properly connected
and then attempt to read it again. If the
same error is reported, read the radio
using the programming system for Tait
Orca conventional or trunked radios and
check that the information in the Radio
Model fields (Specifications screen) is
correct. If this information is incorrect,
reprogram the radio with the correct
information. If the calibration system still
will not read the radio, contact your Tait
dealer.

If Current Status says �Error - bad data in
freq\band item�, use the programming
system for Tait Orca conventional or
trunked radios and check that the

frequency band information in the Radio
Model fields (Specifications screen) is
correct.

If Current Status says �Calibration
database checksum corrupt�, the database
read from the radio cannot be used for
calibrating the radio. You can use the
default database or a previously saved
database. You should perform a full
calibration to avoid damaging the radio.

Using the default database
The default database is automatically
loaded when you start the calibration
system, and if you have not been able to
successfully read a radio, this is the
database that will be used. You can also
open a copy of the default database by
selecting New from the File menu.

Using a previously saved database
The Load option in the File menu
retrieves a calibration database from a
disk. When you select Load, the Load
Database window appears (Figure 8).

The Drives list shows all the drives
associated with your computer.

Figure 8: Load Database window
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Figure 9: Save Database window

The Directories list shows all the
directories immediately available on the
selected drive. When you select a directory,
the next level of directories appears. The
previous level of directories is indicated by
the �..� symbol.

The Files list shows all files in the current
directory with the properties shown in the
File Name box. The default is �*.ocs�. You
can search for files using the DOS
wildcards �*� and �?�.

Select the database you wish to load by
clicking on the file name displayed in the
Files list, or use Tab to select the file name
and then press Enter. Select OK to load
the file.

Select OK to load the database indicated in
the File Name field.

Saving a calibration database
on disk
The Save As option in the File menu saves
the current calibration database on disk.
When you select Save As, the Save
Database window (Figure 9) appears and

prompts you to specify a path and name
for the file. Enter the name of the file in the
File Name box, then select the drive and
directory where you wish to save the file.

The Files list shows all files in the current
directory with the properties shown in the
File Name box. The default is �*.ocs�.

The Directories list shows all the
directories immediately available on the
selected drive. When you select a directory,
the next level of directories appears. The
previous level of directories is indicated by
the �..� symbol.

The Drives list shows all the drives
associated with your computer.

Select OK to save the database.

The Save option in the File menu saves
the current calibration database on disk
and is only available when a file has been
loaded or has already been saved using the
Save As command.
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Figure 10: The Calibrate menu

Calibration tests

The Calibrate menu contains options that
put the radio through a series of calibra-
tion tests. It is divided into three sections
(see Figure 10).

The first section contains one option,
Calibrate All, which takes you through
each of the calibration tests in sequence. If
you do not need to do a full calibration,
each of the tests can be selected individu-
ally from the second section of the
Calibrate menu.

The tests are:

■ PA Bias Calibration

■ TCXO Calibration

■ Front End Tuning

■ Squelch Thresholds

■ Power Control

■ Modulation Balance

■ Maximum Deviation

■ Maximum Volume Threshold

■ RSSI Thresholds

■ Battery Thresholds.

The last section of the Calibrate menu
contains one option, Advanced Settings,
which is not a calibration test but allows
you to change CTCSS and DCS signalling
deviations. Changes to these settings
should only be made under special
circumstances.

Each calibration test window includes
step-by-step instructions on how to carry
out the test. The calibration test unit�s
external PTT should be set to Rx for all
tests.
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Figure 11: PA Bias Calibration window

Some tests are frequency dependent and
so must be carried out across the range of
test frequencies.

Once a test is finished, select OK to exit the
window and save the data, or Cancel to
exit the window without saving the data.

PA Bias Calibration
This test only applies to handportable
radios.

The final transistor in the Tait Orca
handportable radio must be biased at a
constant current. Each transistor is
different and so requires a different voltage
to obtain the same current.

This test should be carried out with no RF
power transmitted (calibration test unit set
to Rx), and requires a digital current meter
capable of measuring current up to 3 A
accurate to two decimal places.

The current meter should be connected in
series with the power supply to the radio
before the radio is turned on. If it has not
been connected, you must turn off the
radio and connect the current meter as
described on page 8. Then turn the radio
back on.

Select PA Bias Calibration from the
Calibrate menu and the window shown in
Figure 11 will appear.

Set PA Bias Adjustment to 0, then note
the DC current consumed by the radio.
Slowly increase PA Bias Adjustment until
the current consumed by the radio
increases by the amount shown in Target
Current Increase.

Select OK to exit the PA Bias Calibration
window.
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Figure 12: TCXO Calibration window

TCXO Calibration
The TCXO (temperature compensated
crystal oscillator) provides the reference
frequency from which all other RF
frequencies are derived. The TCXO
requires careful alignment to ensure that
the transmitter and receiver are on
frequency.

This test must be carried out at a room
temperature of 25ºC (±5ºC), and should be
completed as rapidly as possible since
extended transmission times increase
temperature, thereby making the
calibration test less reliable.

Select TCXO Calibration from the
Calibrate menu and the window shown in
Figure 12 will appear.

Connect the radio�s antenna connector to
the frequency measuring input, and set the
calibration test unit�s audio input switch to

Off. If Fine TCXO Adjustment is outside
the range 115 to 140, set it to 127.

Adjust Coarse TCXO Adjustment so that
the frequency displayed is as close as
possible to Target Frequency. Then
adjust Fine TCXO Adjustment so that the
frequency displayed is as close as possible
to Target Frequency.

Select OK to exit the TCXO Calibration
window and save the coarse and fine
values.

Front End Tuning
The front end tuning voltage sets the
centre of the bandpass filter in the receiver
section of the radio. The TCXO must be
correctly calibrated before the front end
can be tuned.

Select Front End Tuning from the
Calibrate menu and the window shown in
Figure 13 will appear.
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Figure 13: Front End Tuning window

Connect the radio�s antenna connector to
the RF signal output, and set the RF signal
to -100 dBm, the deviation specified in
Test Deviation and the modulation rate to
1 kHz.

For each Test Frequency, set the RF
frequency to the currently selected Test
Frequency. Select AutoTune to automati-
cally adjust Max RSSI Finder, Upper
RSSI Finder and Lower RSSI Finder.

If AutoTune fails, the signal strength may
be too weak or the radio may be faulty.
Check the test setup and make sure all
connections are secure. If AutoTune fails
again, contact your Tait dealer.

Select OK to exit the window and save the
values of Upper RSSI and Lower RSSI for
each of the test frequencies.

Squelch Thresholds
Squelch opening and closing levels are
defined by independent values in the
calibration database. There are two
programmable squelch settings for Tait
Orca radios since different operating
environments contain different amounts
of RF noise. These settings are �country�
and �city� and correspond to nominal
settings of 12 dB and 16 dB SINAD
respectively. Squelch is bandwidth
dependent and so the test must be carried
out for each bandwidth at which the radio
operates.

Select Squelch Thresholds from the
Calibrate menu and the window shown in
Figure 14 will appear.

Connect the SINAD metering input to the
calibration test unit�s SINAD output. Set
the calibration test unit�s dummy load
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Figure 14: Squelch Thresholds window

switch to the Test Load specified. Connect
the radio�s antenna connector to the RF
signal output, and set the RF signal to the
frequency specified by Test Frequency.

For each Test Deviation, set the RF signal
to the deviation specified by Test
Deviation with a modulation rate of 1 kHz.

For the opening level, adjust the signal
power so that the SINAD reads 12 dB.
Adjust Mute Open Adjustment until a
single increment causes Mute Status to
change from �Closed� to �Open�. If this
changes over an increment greater than
one, adjust the Mute Open Adjustment
until Mute Status reads �Closed� and
repeat this step. This step can be carried
out automatically by selecting the Autoset
button; however, you must still adjust the
signal power for the appropriate SINAD.

For the closing level, decrease the RF signal
power by 2.5 dBm. Adjust Mute Close
Adjustment until a single increment
causes Mute Status to change from �Open�
to �Closed�. If this changes over an
increment greater than one, adjust Mute
Close Adjustment until Mute Status
reads �Open� and repeat this step. This step
can be carried out automatically by
selecting the Autoset button; however, you
must still adjust the signal power for the
appropriate SINAD.

Once the test has been carried out at all
Test Deviations, select OK to exit the
window and save the squelch opening and
closing values.
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Figure 15: Power Control window

Power Control
Power control must be calibrated for high,
mid and low power at five points across
the radio�s frequency band to ensure a flat
power output across the operating band.

The PA Bias Calibration test must be
carried out before the Power Control test.

This test requires a total of 15 adjust-
ments, three at each test frequency, and
must be carried out with 7.5 V at the radio
terminals for handportable radios and
13.8 V at the DC service lead test terminals
for mobile radios.

Select Power Control from the Calibrate
menu and the window shown in Figure 15
will appear.

Connect the radio�s antenna connector
directly to the RF power measuring input.
If using a cable other than that provided in

the service kit, make sure it is as short as
possible and of high quality.

Set the calibration test unit�s audio input
switch to Off and make sure the input
voltage at the radio terminals while
transmitting is 7.5 V at the radio terminals
for handportable radios and 13.8 V at the
DC service lead test terminals for mobile
radios.

At each Frequency, adjust the three power
levels so the measured power is as close to
the target power output (Low Power, Mid
Power and High Power) as possible.

Select OK to exit and save the power
adjustments, which are used to calculate
the correction factor for all frequencies in
the radio�s operating band.
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Figure 16: Modulation Balance window

Modulation Balance
Tait Orca radios modulate the signal into
both the TCXO and VCO sections of the
synthesiser in an attempt to get a flat
response made up of the two modulation
inputs.

Select Modulation Balance from the
Calibrate menu and the window shown in
Figure 16 will appear.

Connect the radio�s antenna connector to
the modulation measuring input, and set
audio filtering to <20 Hz HPF and >15 kHz
LPF. Turn off de-emphasis and set IF
filtering to >50 kHz.

Connect the audio signal output to the
calibration test unit�s Tx Audio input and
set the audio input switch to Mod Audio.

Set the frequency of the generated audio
signal to 70 Hz and adjust the amplitude

to give a deviation as close as possible to
the Target Base Deviation.

Set the signal frequency to 7 kHz and
adjust VCO Modulation Adjust to reset
the deviation as close as possible to the
Target Base Deviation.

Check the deviation at 70 Hz is still the
Target Base Deviation; if not so, readjust
the audio signal output, then set the
frequency of the audio signal to 7 kHz and
adjust VCO Modulation Adjust until it is.

Set the audio signal to 7 kHz. In each box
under Measured Deviations, record the
signal deviation by first clicking in the box
and then recording the value shown on the
modulation measuring input.

Select OK to exit the window and save the
values of Measured Deviations.
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Figure 17: Maximum Deviation window

Maximum Deviation
Maximum deviation must be set to ensure
that the maximum modulation deviation
from the centre frequency does not exceed
statutory limits. The Modulation Balance
test must be carried out before the
Maximum Deviation test.

Select Maximum Deviation from the
Calibrate menu and the window shown in
Figure 17 will appear.

Connect the radio�s antenna connector to
the modulation measuring input. Set
audio filtering to <50 Hz HPF and >15 kHz
LPF. Turn off de-emphasis and set IF
filtering to >50 kHz.

Connect the audio signal output to the
calibration test unit�s Tx Audio input and
set the audio input switch to Mic Audio.

Set the audio generator to give a 1 kHz
sinusoidal signal. Observe the modulated
waveform on the oscilloscope, and adjust

the amplitude of the audio signal to give a
maximum response without clipping, then
increase the audio level by 20 dB.

Adjust the frequency of the audio
generator from 300 Hz to 3 kHz to find the
maximum deviation. Adjust TCXO
Modulation Adjust so that the deviation
on the modulation measuring input equals
the Target Deviation.

If the value of TXCO Modulation Adjust
change by more than 20 percent, you will
need to recheck the TCXO Calibration.

Select OK to exit the window and save the
value of TCXO Modulation Adjust.

Maximum Volume Threshold
The maximum volume threshold is set to
ensure that the radio�s speaker is not
overdriven. Select Maximum Volume
Threshold from the Calibrate menu and
the window shown in Figure 18 will
appear.
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Figure 18: Maximum Volume Threshold window

Connect the oscilloscope across the
calibration test unit�s SINAD output. On
the calibration test unit, ensure the
external PTT is set to Rx and the audio
output switch is set to Int. Set the load
switch to the Test Load specified.

Connect the radio�s antenna connector to
the RF signal output. Set the RF signal to
the Test Frequency and Test Deviation
specified at a power of -47 dBm, and
modulate the carrier with a 1 kHz signal.

Ensure that the radio�s volume control is
set to its maximum position. Change
Volume Adjustment so the oscilloscope
shows the Target Amplitude.

Select OK to exit the window and save the
value of Volume Adjustment.

RSSI Thresholds
The received signal strength indicator
(RSSI) must be calibrated to give an
accurate measurement of received signal
strength. The correct calibration of RSSI
thresholds is critical for the proper
operation of trunked radios.

Select RSSI Thresholds from the
Calibrate menu and the window shown in
Figure 19 will appear.

Connect the radio�s antenna connector to
the RF signal output. Set the RF signal to
the Test Frequency and Test Deviation
specified, modulated with a 1 kHz
sinusoid. Set the RF signal power to -116
dBm and select the Set L0 button. Then
set the RF signal power to -100 dBm and
select the Set L2 button. -116 dBm and
-100 dBm are standard RSSI levels; your
trunking system may require different
levels.
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Figure 19: RSSI Thresholds window

Select OK to exit and save the displayed
RSSI values.

Battery Thresholds
This test only applies to handportable
radios.

The voltage into the radio must be
accurately measured so that the radio can
calculate low battery states. Select Battery
Thresholds from the Calibrate menu and
the window shown in Figure 20 will
appear.

With a power supply connected to the DC
service adaptor, adjust the voltage to give
an output between 6 and 9 volts, then use
the digital multimeter to accurately
measure the voltage across the two points
at the base of the DC service adaptor.

Enter the voltage reading in Measured
Voltage, then select OK to exit the window
and save Measured Voltage.

Advanced Settings
The Advanced Settings window is used to
change settings relevant to DSP signalling
deviations. Select Advanced Settings
from the Calibrate menu and the window
shown in Figure 21 will appear.

These settings should only be adjusted for
special system requirements.

The CTCSS and DCS settings are the
deviations applied when subaudible
signalling is used. The voice deviation is
adjusted to keep the overall deviation
within statutory limits. When subaudible
signalling is not enabled on a channel,
voice deviation will not be affected.

Enter the required signalling deviations,
then select OK to exit the window and save
the settings.
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Figure 21: Advanced Settings window

Figure 20: Battery Thresholds window
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Figure 22: Radio Program window

Programming a radio

Once the calibration tests are complete,
the information obtained is used to
program the radio�s calibration database.

When the Program option is selected
from the Radio menu, a message will
appear telling you that the radio is being
programmed. Once programming is
complete, the Radio Program window
(Figure 22) appears.

The field Current Status shows the
current status of the radio and database,
and should read �Radio successfully
programmed�.

Problems programming a radio
If when you program a radio, Current
Status reports �Error - failed to program
dbase item� or any other type of error,
check that the connections between the
radio and the calibration test unit and
between the calibration test unit and the
PC are intact and select the ReProg
button.

If the calibration system still returns an
error, save the calibration database to disk,
exit the calibration system and restart the
computer. Load the saved calibration
database and again try to program the
radio.

If you still cannot program the radio,
contact your Tait dealer.
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Appendix: Test commands

Below are listed the test commands
available through the Test Commands
option of the Utility menu. Select the
command, then Send to send the
command to the radio. Returned
information will be displayed, together

with any error messages. Where a test
command requires additional parameters,
these will appear when the command is
selected from the list.

A description of error codes is also
included.

Function Description CCTM code Parameters

Signalling Set modem to send zeros 10 None

Set modem to send ones 11 None

Set modem to send preamble 12 None

Disable modem signalling 13 None

Read modem receive string (continuous) 14 None

Disable all signalling 15 None

Enable subaudible signalling 16 None

Read subaudible signalling decode status 17 Returns: 0 = signal not
detected,
1 = signal detected

Mute Force Rx audio muted 20 None

Force Rx audio unmuted 21 None

Mute DSP input 22 None

Unmute DSP input 23 None

Let squelch control Rx audio 24 None

Read RX_BUSY status 25 Returns: 0 = busy inactive,
1 = busy active

Relax Rx mute control 26 None

Rx/Tx Inhibit PA (transmit mode) 30 None

Enable PA (transmit mode) 31 None

Set radio to Rx 32 None

Set radio to Tx 33 None

Set transmit to low power 34 None

Set transmit to mid power 135 None

Set transmit to high power 35 None

Set transmit to max power 36 None

Set transmit to no power 137 None

Activate economy mode 42 None

Deactivate economy mode 43 None

Read battery level 46 Returns: 0 to 255

Read temperature level 47 Returns: 0 to 255(continued on
next page)
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(continued on
next page)

Function Description CCTM code Parameters

Rx/Tx (cont’d) Set keypad test on 50 None

Set keypad test off 51 None

Set display test on 52 IN: 0, 1, 2 or 3

Set display test off 53 None

Read averaged RSSI level 63 Returns: 0 to 255

Read L1 threshold 64 Returns: 0 to 255

Read L2 threshold 65 Returns: 0 to 255

Miscellaneous Select normal micro clock 70 None

Select birdie micro clock 71 None

Read synth lock status 72 Returns: 0 = not in lock,
1 = in lock

Select external speaker/microphone 74

Select internal speaker/microphone 75

Stop the MCU clock 79 None

Select wide band 84 None

Select medium band 85 None

Select narrow band 86 None

Select city squelch 88 None

Select country squelch 89 None

Radio info Read radio serial number 94/131 Returns: 6 digit number
(hex)

Read DSP software version number 132 Returns: 4 digit number
(hex)

Read radio software version number 96 Returns: 4 digit number

Read radio type 130 Returns: radio type (P or
M), frequency band (B-J),
channel spacing (1 or 2)

Synth Load absolute synth frequency 101 tttttt T rrrrrr R F

Load synth reference divider 102 8 to 16383

Config Set volume pot 110 0 to 255

Set transistor gate bias 111 0 to 255

Set TCXO mod 112 0 to 255

Set VCO mod 113 0 to 255

Set Tx power level 114 0 to 255

Set TCXO coarse frequency 115 0 to 255

Set TCXO fine frequency 116 0 to 255

Set Rx front end tuning 117 0 to 255

Set squelch threshold 118 0 to 255

Set CTCSS modulation 120 0 to 32767

Set DCS modulation 121 0 to 32767

Set FFSK modulation 122 0 to 32767

Set Selcall modulation 123 0 to 32767

Set DTMF modulation 124 0 to 32767
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Error codes
The errors you may receive while the radio
is in test mode are outlined below.

{C01}
An invalid command code has been
received. Try sending the command again.

{C02}
A (valid) command code has been received
but with invalid parameters. Check the
parameters and try sending the command
again.

{C03}
A (valid) command code has been received
but it cannot be processed at this time. Try
sending the command again.

If the error persists, turn the radio off,
then on again and put the radio into test
mode. If the error still persists, contact
your Tait dealer.

{C04}
An error occurred during the initialisation
of test mode. Turn the radio off, then on
again and put the radio into test mode.

If the error persists, contact your Tait
dealer.

{X01}
EPROM checksum error. The software
code in the flash has been corrupted. Re-
download the radio software.

If the error persists, the flash needs to be
replaced. Contact your Tait dealer.

{X02}
Internal RAM failed. The RAM in the
microprocessor is faulty and the micro-
processor needs to be replaced. Contact
your Tait dealer.

{X03}
External RAM failed. The RAM in the
ASIC is faulty and the ASIC needs to be
replaced. Contact your Tait dealer.

{X04}
The DSP is not responding. Check the DSP
for pin connections.

If the error persists, the DSP needs to be
replaced. Contact your Tait dealer.

{X05}
The DSP version number is incorrect. The
radio software and DSP software are
incompatible. The DSP needs to be
replaced with a later version. Contact your
Tait dealer.

Function Description CCTM code Parameters

Config (continued) Set voice modulation 125 0 to 32767

Force DCS signalling (023 tone) 126 None

Force CTCSS signalling (67.0 Hz) 127 None

Force Selcall signalling (2000 Hz 128 None
for 2 seconds)

Force DTMF signalling (tone A) 129 IN: 1 = start encoding,
0 = stop encoding

Read calibrated volume setting 136 Returns: 0 to 255
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{X06}
The MCU internal configuration is
incorrect. Contact your Tait dealer.

{X09}
The prototype timer has expired. This
error will only occur on prototype software
releases when the radio usage time has
expired.

New radio software must be downloaded
into the radio and the new software must
have a different software version number.

{X31}
Model configuration checksum error. This
error indicates that the radio�s model
configuration checksum is incorrect.
Contact your Tait dealer.

{X32}
Database checksum error. This error
indicates that the radio�s database
checksum is incorrect. Contact your Tait
dealer.

{X33}
ESN error. The radio�s electronic serial
number is incorrect. Contact your Tait
dealer.

{X35}
Temperature is above the T1 threshold and
turn down of transmit power is impend-
ing. To avoid damaging the transmit
circuitry, stop transmitting and allow the
radio to cool down before continuing.

{X36}
Temperature is above the T2 threshold and
turn off of the transmitter is impending.
To avoid damaging the transmit circuitry,
stop transmitting and allow the radio to
cool down before continuing.

{X37}
Voltage is less than the V1 threshold; the
radio will give a low battery warning.
Replace the battery or use a DC service
adaptor.

{X38}
Voltage is less than the V2 threshold. The
radio turns itself off after indicating this
error and so will be unable to respond to
the reset command character.

Replace the battery or use a DC service
adaptor.
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Tait Electronics Limited
Software Licence Agreement

This legal document is an Agreement between you
(the “Licencee”) and Tait Electronics Limited (“Tait”).
By opening this product package and/or using the
product you agree to be bound by the terms of this
Agreement. If you do not agree to the terms of this
Agreement, do not open the product package and
immediately return the unopened product package
to Tait. If you open the product package, that will be
deemed to be acceptance of the terms of this li-
cence agreement.

Licence
In consideration of the payment of the Licence Fee,
which forms part of the price you paid for products
you acquired from Tait or its subsidiary or agent
(the “products”) and our willingness to be bound
by the terms of this agreement, Tait grants to you
as Licencee the non-exclusive right to use the copy
of a Tait software program included in the products
(the “Software”).

In particular, the Licencee may use the program on
a single machine and if the software is supplied on
a diskette, the licensee may:
(a) Copy the program into any machine readable

or printed form for backup purposes in sup-
port of your use of the program on the single
machine (certain programs, however, may in-
clude mechanisms to limit or inhibit copying;
they are marked “copy protected”), provided
the copyright notice must be reproduced and
included on any such copy of the Software.

(b) Merge it into another program for your use on
the single machine. (Any portion of this pro-
gram merged into another program will con-
tinue to be subject to the terms and condi-
tions of this Agreement.)

The Licencee may not duplicate, modify, reverse
compile or reverse assemble the Software in whole
or part.

Title to software
This agreement does not constitute a contract of
sale in relation to the Software supplied to the
Licencee. Not withstanding the Licencee may own
the magnetic or other physical media on which the
Software was originally supplied, or has subse-
quently been recorded or fixed, it is a fundamental
term of this Agreement that at all times title and
ownership of the Software, whether on the original
media or otherwise, shall remain vested in Tait or
third parties who have granted licences to Tait.

Term and termination
This Licence shall be effective until terminated in
accordance with the provisions of this Agreement.
The Licencee may terminate this Licence at any
time by destroying all copies of the Software and
associated written materials. This Licence will be
terminated automatically and without notice from
Tait in the event that the Licencee fails to comply
with any term or condition of this Agreement. The
Licencee agrees to destroy all copies of the Soft-
ware and associated written materials in the event
of such termination.

Limited warranty
The Software is supplied by Tait and accepted by
the Licencee “as is” without warranty of any kind
either expressed or implied, including but not be-
ing limited to any implied warranties as to
merchantability or fitness for any particular purpose.
The entire risk as to the quality and performance of
the Software vests in the Licencee. Should the Soft-
ware prove to be defective, the Licencee (and not
Licensor or any subsidiary or agent of the Licensor)
shall assume the entire cost of all necessary servic-
ing, repair or correction. Tait does not warrant that
the functions contained in the Software will meet
the Licencee’s requirements or that the operation
of the Software will be uninterrupted or error free.
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However Tait warrants that the diskettes if any on
which the Software is supplied to the Licencee shall
be free from defects in material and workmanship
under normal use and service for a period of ninety
(90) days from the date of delivery to the Licencee.

Exclusion of liability
Tait’s entire liability and the Licencee’s exclusive
remedy shall be:
1. The replacement of any diskette not meeting

Tait “limited warranty” and which is returned
to Tait or an authorised agent or subsidiary of
Tait with a copy of the Licencee’s purchase
receipt; or

2. If a diskette is supplied and if Tait is unable to
deliver a replacement diskette that is free from
defects in material or workmanship, the
Licencee may terminate this Agreement by
returning the Software to Tait.

3. In no circumstances shall Tait be under any
liability to the Licencee, or any other person
whatsoever, for any direct or consequential
damage arising out of or in connection with
any use or inability of using the Software.

4. Tait warrants the operation of the Software only
with the operating system for which it was de-
signed. Use of the Software with an operating
system other than that for which it was de-
signed may not be supported by Tait, unless
otherwise expressly agreed by Tait.

General
The Licencee confirms that it shall comply with the
provisions of law in relation to the Software.

Law and jurisdiction
This Agreement shall be subject to and construed
in accordance with New Zealand law and disputes
between the parties concerning the provisions hereof
shall be determined by the New Zealand Courts of
Law. Provided however Tait may at its election bring
proceedings for breach of the terms hereof or for
the enforcement of any judgement in relation to a
breach of the terms hereof in any jurisdiction Tait
considers fit for the purpose of ensuring compli-
ance with the terms hereof or obtaining relief for
breach of the terms hereof.

No dealings
The Licencee may not sublicense, assign or trans-
fer the licence or the program except as expressly
provided in this Agreement. Any attempt otherwise
to sublicense, assign or transfer any of the rights,
duties or obligations hereunder is void.

No other terms
The Licencee acknowledges that it has read this
agreement, understand it and agree to be bound
by its terms and conditions. The Licencee further
agrees that this is the complete and exclusive state-
ment of the agreement between it and Tait in rela-
tion to the Software which supersedes any proposal
or prior agreement, oral or written and any other
communications between the Licencee and Tait re-
lating to the Software (LS-589).
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